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Installation

With the release of the Palm IllI, there are now two programs available for
installing PalmPilot software. Below are instructions for installing software
using the Palm desktop version 3, and prior versions of the Palm desktop. You
can see your Palm desktop version number by choosing “About Palm Desk-
top” from the Help menu, (or the Apple menu for Macintosh users.)

Palm Desktop 3.0 Installation

Start the Palm Install Tool by either selecting it from the Start menu in the
Palm Desktop group, or by clicking the Install button on the left side of your
Palm desktop software.
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Click the Add button on the right hide side and select the AirMiles.prc file.
Click Open, then click the Done button. Next, put your PalmPilot organizer in
its cradle and press the HotSync button. Tap the applications button on your
PalmPilot, and then tap the AirMiles button to start AirMiles.

Installing with Palm Desktop 2.0 and Earlier

Start the InstApp application that came with your PalmPilot organizer. The
InstApp program is located in your Pilot directory where you installed your
other PalmPilot software.

If you are using Windows, you may have to locate InstApp using the Windows
Program Manager or Windows Explorer. It might not appear in the Start menu
or the Pilot program group.



0 =—""———rilot Install Tool =—"r——=H

Select the file to install on your Pilot then press
. the "Install” button to prepare for upload during
the next HotSync.

File Name | | [ Select...]

User [ My User Name |

[(instan... J| [ Bxit |

Click the “Select” button and select the “AirMiles.prc” file, and press OK.
Then press the “Install” button and quit the application.

AirMiles is now ready to be installed on your PalmPilot organizer. The final
step is to put your PalmPilot organizer in its cradle and press the HotSync
button.

After HotSync has completed, tap the Applications icon on your PalmPilot.
Tap the AirMiles icon to start AirMiles.



Overview

Tracking frequent flyer miles with AirMiles is similar to tracking transactions
using a checkbook. As you earn miles through flights, credit card transactions,
phone calls, etc., you record the number of miles you earned into AirMiles and
they add to your total. Once you have enough miles and redeem them for an
award, you record the number of miles for that award, and those miles are
removed from your total active miles.

By keeping your mileage entries up to date, you can make sure that your
programs are correctly tracking your mileage and awards, and you can make
informed decisions regarding services that you are purchasing.

For example, let’s say you are in the airport, at the rental car counter. Various
rental cars offer mileage for specific airlines. By referring to AirMiles, you

can quickly know which program is closest to obtaining an award for you, and
use that information in your purchasing decision

List View

List View Screen

The list view gives you an overview of all the transactions you have entered.
The drop down menus at the top of the screen let you customize the view by
showing only transactions of a particular type, for a particular program, or in a
particular year.

|m w fll types

w Al ‘Years w All prograrn:

O 11726 % Free ticket!  -150000
O 11417 ™= SFC to Miarmi 4450
O 11412 ™= Miarni to Philly 26500
112 T rnagazine con... 500
O 11412 #esRental car 120003
#1112 b Hotel bonus 1800037
1112 &2 Credit card 234503
& 11710 ™= Philly ta SFO 3287
916 "= Denvver to Chicago Se0
916 = Chicago to Denver SE0[

| Meaw | = 7132

Check boxes next to each transaction help you reconcile the transactions
against the statements that your receive from your programs. An open check
box indicates a transaction that has not been reconciled. A checked box indi-
cates a transaction that is in the process of being reconciled. Transactions that
do not have a check box have been reconciled.



The total at the bottom of the screen shows you total miles for checked or
unchecked items as an aid to reconciling your statements.

Edit View

Edit View Screen

The edit view allows you to add and edit mileage transactions. You choose the
type of transaction, what program the transaction was for, and add your
mileage information.

| AirMliles Edit

Twpe: w Flight

Prograrn: = United

Date:  {Mon 3716, 96
Miles: 00 Segs
Bonus: 125 (20%

Expires: B3 wears

Descr:  Denwver to Chicago -

[ Lone | [elete..] [ Hote...

Expiration and Bonus information is automatically calculated for you, but you
may override the calculation by simply entering your information in the
default screen.

Reports

Mileage Report

Reports are available from the List View menu.

Mileage Rpt. w Lnited

Exp. Miles HAwards Balance
2000 16,032 13,815 2,217
19949 1,185 1,185 1]

Total Active Miles: 2 217
Lifetirne Miles: 17,217
Lifetirne Awards: 15,000

| Done |

The Mileage report shows you how many active miles you currently have in
each program, when they will expire, and what your program totals are. This
report can answer questions like: “How many miles will expire this year if |



Flight Report

do not use them in an award?”, and “How many more miles do | need to

achieve the next award?” Use this report to plan your strategy for achieving
awards.

Year Seqnents hiles
1997 17 14,839
1996 2 1120

Lifetirne Segrents: 19
Lifetime Miles: 15,959

| Done |

The Flight report shows you flight segments and mileage that come from
flight transactions only. Many frequent flyer programs offer special privileges
and bonus miles to people who fly a certain number of segments in a year and

a certain number of miles. Use this report to plan your strategy for achieving a
bonus program.



Getting Started

Setting up Types

Use types to categorize the source of the miles in a transaction. For example,
if you had miles from a flight, you would enter those miles with the “flight”

type.
AirMiles comes with a predefined list of types that are not editable. This list

includes: Awards, Flights, Credit Cards, Phone calls, Rental Cars, Restaurants,
Lodging, and Opening Balances.

Predefined Type List Award

Credit Card
Phone

Rental Car
Restaurant
Lodging

Cpening Balance
Cither

Edit other tvpes...

If you have other sources of transactions that you would like to categorize,
you can add them to this list at any time, by doing the following:

Tap on the type list, either in the List View or the Edit View.

Choose “Edit other types” from the list that appears. You will then see the
following dialog.

Edit Type List Screen Edit Type List

(Cone] [Mew ] [Edit. ] [ Delete ]




Enter New Type

To add a new type, tap the New button at the bottom of the screen. Enter the
name of the new type you want to use and tap Done.

Edit Type List

Enter a new name:

[ Done | [<ancel | +

To edit a type that you have previously added, tap the type in the type list,
then tap the Edit button and change the name to the one you want.

When you have finished entering types, tap the Done button

Setting up Programs

Edit Program List

The program list lets you categorize mileage by what award program those
miles are for. Programs are normally the names of the airline that you fly with,
but may be other names in special circumstances.

AirMiles comes with a predefined list of programs that you can edit or delete
at will. To edit the program list, choose “Edit programs” from the program
drop-down list in the List View or Edit View.

Edit Program List

United
Continental

(Cone] [Mew ] [Edit. ] [ Delete ]

To add a new program, tap the New button at the bottom of the screen.

To edit a program, select the program and tap the Edit button at the bottom of
the screen.
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Edit Program Screen

Program Details

Program:

Accont. #F:

[ Done ] [ <ancel |

Enter the name of the program in the Program field. This is the name that will
appear on the program list.

Enter the account number, or other information into the account field. This
information is only for your own reference and is not used by the program in
any other way.

If your program miles expire after a given number of years, make sure that the
Miles Expire check box is checked and enter the number of years that miles
will normally expire in for your program. This information is used as the
default value for new transactions. You can override this value for specific
transactions in the Edit screen.

If you have achieved a bonus program, enter your bonus percentage in the
bonus field. AirMiles will automatically use this value to compute bonuses on
“Flight” type transactions. The computed bonus value can also be overridden
for individual transactions in the Edit View.

Setting up Opening Balances

If you are like most people, you are already a member of at least one award
program. AirMiles can help you start tracking miles for these programs,
starting today.

For AirMiles to properly compute your future mileage and awards for pro-
grams that you already are using, you must correctly enter opening balances
for each program.

The following step by step instructions will guide you through the process of
setting up opening balances.

Overview

You will create one opening balance transaction for each year that you have
accumulated miles, as listed on your statement.

The current year’s balance is the most complicated entry. For this year, you
will essentially enter:

* The number of miles that you accumulated this year
* The number of years in which the miles will expire

11



Adding Opening Balance

* The number of flight miles earned this year
* The number of non-flight miles earned this year
* The number of segments for the current year

Mileage that you have earned in years previous to the current one are easier,
and do not requireyou to distinguish between flight and non-flight miles.

Making a New Transaction

To enter your opening balances, make sure your current program statement is
available and do the following:

1) Tap the New button at the bottom of the List View to create a new mileage

transaction.
2)
3)

Select “Opening Balance” from the type list.

Select the program from the program list. If your program is not in the
program list, follow the instructions in the previous section to add the
program to the program list..

| Airivliles Edit

Twpe: w Cpening Balance

Prograrn: w AAdwantage

Dater  {Mon 11717797

Miles: Seqgs

Bonus:

Expires: B 3 wears

Crescr.: w

[ Cone ] [Delete. ] [ Mote... ] Ll

Entering the Current Year Balances

Look at your statement and find the number of miles on your statement that
qualify for the program’s “Gold” or “Premier” type program. This number
represents the number of “flight” miles you have recorded for the year. Enter
this number in the Miles field in the opening balance.

Find the number of segments on your statement for the bonus program. This
will be the number of flight segments you have flown in the current year.
Enter this number in the segments field.

Now you need to enter the number of non-flight miles (i.e. from credit cards,
bonuses, rental cars, etc.) for the current year. These miles must be entered in
the Bonus field in order to differentiate them from the miles that qualify for

the “Gold” or “Premier” type program. To compute non-flight miles for the

12



SUMMARY DATE:

FROGRAM-TO-DATE MILES:
¥TD GOLD/PLAT QUAL MLG:
¥TD GOLDA/PLAT QUAL SEG:

TRAMGAC TION LA TE |

current year, take the miles you earned this year and subtract the “flight”
miles. Enter this value in the Bonus field.

For example, if the number of miles that you earned this year are 10,000, and
the number of flight miles for the year are 3,000, you would be left with 7,000
miles, which you would enter into the Bonus field.

As another example, below is an example of an actual statement taken from a
popular program.

R ST PRt W ORI

12;31;94
| MILES EXPIRING ON - 12/31/97. 1,394
: - 12/31/98; B2
- 12731799, (3,483
TOTAL AVAILABELE AWARD MILEAGE: | 21,701
TR AT MUEi s O T v T : - -

Current Year's Total Miles Earned

Flight Miles This Year

To create the first opening balance, you would put the current year’s flight
miles in the Miles field (3,928), and the difference between that and the total
miles in the Bonus field (9,483 - 3,928 = 5,555). When you view this transac-
tion in the List View, the total you should see would be 9,483.

You have now entered your current balance for this year. Follow the instruc-
tions in the next section for previous years.

Entering Previous Year Balances

For each year prior to the current year, enter a new opening balance transac-
tion. However, unlike the first year transaction, you do not need to compute
the flight verses non-flight mileage.

1) Create a new opening balance transaction.

2) Select the program name and choose “Opening Balance” as the type.
3) Find the number of miles that will expire from a previous year.

4) Enter that number in the Bonus field.

5) Enter the date that those miles were recorded. The year is the important
information. You can select any date as long as the year is correct.

6) Enter the number of years that the miles will expire in. For example, if the
miles were from 1996, and the miles expire in 1999, enter “3” into the
Expires field. If the miles will not expire, make sure that the Expires check
box is not checked.

Continue to enter miles for each expiring year on your statement. For ex-
ample, if your statement has a listing for 3 years, you should have a total of 3
opening balance transactions after you have entered them all.

13



The Flight Report

Entering Lifetime Miles

Some programs have special bonuses for people who achieve a certain num-
ber of lifetime flight miles. If you are trying to achieve such a goal, you will
want to make sure your lifetime miles are correct by doing the following.

1) Tap the done button to return to the list view.

2) Tap the menu button that is in the lower left-hand corner of your PalmPilot
screen.

3) Select the Flight report from the Report menu.

Year Seqments hiles
19497 2 L X
19964 2 1120

Lifetimne Segrents: 4
Lifetirne Milas: 7057

| Done |

In the flight report, you will see a number for your Lifetime Miles. If this
number is not correct, you will need to make an adjusting entry to fix it.
Simply enter an opening balance transaction, as described above, for the
difference between it and the correct number. Make sure that the date of this
transaction is very old, and the expiration years are small so that these miles
will be recorded as expired. For example, if the current year is 1997, then
enter a date of 1950 and enter 1 as the number of expiration years. Also, be
sure and enter these miles in the Miles field and not the Bonus field.

Reconciling Your Opening Balances

As a final step, you should mark all your opening balances as reconciled.

Go to the list view, and check off each transaction you have entered. You may
need to choose the correct program from the Program list, and set the type to
“All types”.

Make sure the checkbox at the bottom of the screen is checked. This will show
you a total for the miles that are currently checked.

14



Reconcile Balances |m w Al tvpes

w Al ‘Years w All prograrn:

#1124  Qpening balan... 16320
=11s5 Cpening balance 5165
213 Cpeneing balan... 3153

| Mew | E’EU‘IEE

Make sure that this total is correct, and that each entry is correct and checked
off.
Finally, tap the menu button at the bottom left hand corner of your PalmPilot

screen, choose “Reconcile” from the Options menu, and tap the “Yes” button.
This will mark all the items you have checked as reconciled.

Reconcile Screen Reconcile

Mark all checked items
as reconciled 7

I:‘fes :II: Nu:n]

You are now ready to enter new miles.

15



Entering Mileage

Entering Flight Miles

Edit View

To enter flight miles, click the New button at the bottom of the List View
screen.

You will then be presented with the following screen.

| Airivliles Edit

Twpe: w Flight

Prograrn: w AAdwantage

Date:; ;Tue 1 1.-’25.-’9?;

Miles: Segs: |

Bonus:

Expires: B 3 wears

Descr.: -

[ Cone ] [Delete. ] [ Mote... ]

Choose “Flight” from the Type menu, and choose the program from the
program menu. If the program you want to use is not in the list, add a new one
by choosing Edit Programs at the bottom of the program list. See Setting Up
Programs for more information.

Enter the date that the flight was on. Entering the correct date is very impor-
tant. The Mileage report uses this date to determine how to apply awards to
earned mileage.

Enter the mileage of the flight into the Miles field. You should consult your
program provider to find out what mileage you will be credited for a particular
flight. Many programs have a minimum amount that you get, even on short
flights.

Enter the segments into the Segs field. Many programs provide bonuses and
special privileges to travelers who reach a certain number of flight segments
in a given year. Consult your flight program for more information.

If your program gives you bonus miles, enter the number of miles in the
Bonus field. You can set up the program to automatically compute this number
if you would like. See Setting Up Programs for more information.

16



Enter the number of years before the miles expire in the Expires field. If the
miles do not have an expiration date, make sure that the Expires check box is
not checked. You can set up the program to automatically enter this informa-
tion if you would like. See Setting Up Programs for more information.

Finally, add a description of the trip, like the origin and destination, or the
purpose. If you frequently use the same description, you can add it to the
description list. See Editing the Description List below for more information.

If you would like to add additional comments regarding the flight, like the
flight number, tap the Note button at the bottom of the screen and enter your
information.

Entering Other Miles

Adding Non-flight Miles

Adding other mileage information is similar to adding flight information. The
only difference is that you do not have Bonus miles or Segments to enter.

To enter other types of mileage, tap the New button in the List View, and
choose the type from the type list. If you do not see an appropriate type, you
can add a new type by choosing “Edit Other Types” at the bottom of the type
list. See Setting Up Types earlier in this chapter.

| AirMviles Edit

Twpe: » Credit Card

Prograrn: » AAdwvantage

Dater  {Tue 11725757
Miles:

Expires: B2 wears

Descr. w

[ Cone :I [Delete...J [ Mote... :I

Fill in the rest of the entries shown the same as if you were entering flight
information.

Recording an Award

Redeeming an award is similar to entering flight information.

Tap the New button in the List View.

Select “Award” from the type menu, and select the program that the award is
for.

17



Recording an Award | AirMiles Edit

Twpe: W Award

Prograrn: = AAdwvantage

Date: | Tue 11725°97
Miles:

Deszcr.: w

[ Lone | [elete..] [ Hote...

Enter the date on which the award was redeemed. Entering the correct date is
very important, as the Mileage report uses this information to determine how
to apply awards to earned miles.

Enter the number of miles that the award is worth into the Miles field.

Enter a description of what you earned, like “Free flight”, or “First class
upgrade”, etc.

Editing the Description List

The description list is a drop-down list that you can use to quickly enter
information that you enter often.

To edit the description list, first go to the Edit View by tapping the New
button, or tapping on an entry in the List View.

Tap the Menu button in the lower left corner of your PalmPilot screen.

| Record Edit
| Edit Description List  ~E

Options Menu

Select Edit Description List from the Options menu.

Desc. List Window Edit Desc. List

(Cone] [Mew ] [Edit..] [ Delete ]
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To add a new description, tap the New button and enter the description. To
edit a description, select the description from the list and tap the Edit button.

Duplicating an Entry

Another way to speed up data entry is to make a duplicate of a transaction you
have already entered.

For example, if you fly the same flight on a regular basis, instead of entering
the flight information over again, simply select the previous flight, and choose
“Duplicate Record” from the Record menu.

| GIILTE N Edit Options |
Delete Record... D
Duplicate Record L

The new record will have all the same information that the previous record
did, but will have the current date instead of the previous date.

Deleting an Entry

Before deleting a mileage entry, see the warning below.

To delete an entry, first select it from the List View. Then, tap the Delete
button at the bottom of the screen.

Warning!!!

Do not delete old records just because they have been used by an award.
Every time you use the Mileage report, AirMiles recalculates which awards
apply to which programs. Deleting an old transaction could create problems in
this report even for awards that are redeemed many years after the mileage has
expired.

19



Reporting

Mileage Report

Mileage Report

The Mileage report shows you your current balances for each year on which
miles will expire.

To show the mileage report, go to the List View and tap the Menu button in
the bottom left corner of the PalmPilot screen. Then choose Mileage Report
from the Report menu.

TR Reports

Mileage Report I
Flight Report «F

Select the program that you want to review from the program menu in the
upper right corner of the screen.

Mileage Rpt. w Lnitad

Exp. Miles Awards Balance

Mone B.BTT 1] BBTT
2000 16, 032 13,880 2,152
19949 1.120 1.120 0
YT 0 34568 -3456

Total Active Miles: 5,373
Lifetime Miles: 23,5829
Lifetirne Awards: 18,456

| Done |

The mileage report has 4 columns.

The Exp. column shows the year for which the miles will expire. If miles do
not expire, the word “none” will appear here. If an award was redeemed for
which AirMiles could not find corresponding miles to offset the award, you
will see a column with “???” as the expiration year.

The Miles column shows you the total miles earned that expire in that year.
This includes flight miles, bonus miles and other miles.

The Awards column will show you the total for miles that have been redeemed
from the expiration year. Note that one award may redeem miles from more
than one expiration year, depending on the size of the redemption and the
number of miles available for an award in that year.

20



The Balance column will show you the difference between the awards and the
miles for that year.

At the bottom of the screen, you will see 3 totals. The Total Active Miles
shows you the number of miles available for an award. The Lifetime Miles
number is the total number of miles accumulated for the selected program.
The Lifetime Awards column shows you the total number of miles you have
used in awards for the selected program.

How the Mileage Report Works

If there are discrepancies between the mileage report and your statements, it
may be helpful to know how the report works to resolve the problem.

The Mileage Report starts with the oldest mileage or award entered for the
program selected in the program list and adds its amount to the correct row
and column as described below. It does this for each entry in reverse date
order.

If the entry is not an award, it adds the miles and bonus to the column that
corresponds to the year in which those miles will expire. For example, if the
miles will expire in 1999, it adds the miles and bonus to the Miles column in
the 1999 row.

If the entry is an award, it looks for miles that can offset the award amount. It
starts with the expiration year that corresponds to the year the miles were
entered, and proceeds to the next, and next until it finds enough unawarded
miles to equal the award amount. It then will add the correct amount to each
year’s award amount. If AirMiles cannot find enough mileage to equal the
award amount, it will put what is left in a row marked ‘“???’ in the Exp. col-
umn.

Note that since this whole procedure occurs in the order in which records
appear by date in the list, it is possible to have plenty of unawarded miles in
the list, but still get award miles to show up in a “???” row. The reason is
likely that the dates for the award or earned mileage are incorrect. It might be
caused by miles that were added after the award date, or miles that expired
before the award date.

Flight Report

The flight report shows you the miles and segments that have been used only
for flights. Many reward programs offer bonuses and special privileges to
people who achieve a certain number of flight miles or awards in a particular
year.

To see the Flight report, select Flight Report from the report menu in the List
View.

I Reports
Mileage Report I
Flight Report « F

21



Then select the program from the Program list in the upper right corner of the
screen.

Flight Report |m  Lnited

Year Seqnents Mhliles
1997 17 14,839
19964 2 1120

Lifetirne Segrents: 19
Lifetime Miles: 15, 959

| Done |

The three columns you see will show you:
* The year the flights were entered
* The number of segments for that year

* The number of flight miles for that year

At the bottom of the screen, you will see your lifetime segments and lifetime
flight miles.

22



Reconciling

List View

To reconcile your statements, first go to the List View. If you are not in the
List View, tap the Done button in the screen you are on until you get to the
List View.

|m w fll types

w Al ‘Years w All prograrn:

O 11726 % Frea ticket!  -1500001%
1117 = SF o Miami 4450
1112 = Miarni to Philly 265000
1112 T% magazine con... 500
11712 s Rental car 12003
#1112 b Hotel bonus 1800037
& 11122 Credit card 23457
11710 = Philly ta SFO 32870
916 "= Denvver to Chicago Se0
916 = Chicago 1o Denver S0 DE

| Mew | E’ 16032

Choose the program you are reconciling from the Program list, and choose
“All types” from the Type list. Choose “All Years” from the year list.

Find transactions in the list that correspond to transactions on your statement.
When your find a transaction, verify that the amount is correct, and check it
off if it is. To put a checkmark in a checkbox, tap once on the checkbox. If the
amount is not correct, you will need to resolve the issue with your program
provider.

If transactions appear on your statement that you have not entered, enter them
now. Make sure you check them off after you verify they are correct.

Make sure the check box at the bottom of the screen is checked, then compare
the total that appears next to the check mark with the total on your statement.
If the totals do not match, review your entries and verify that every transaction
you have checked is correct and that all the transactions on your statement
have been entered and checked.

If the totals match, choose “Reconcile” from the Options menu. Tap the Yes
button, and all the checked items will be marked as reconciled.
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Backing Up and Restoring Data

Every time you HotSync, the HotSync manager automatically makes a copy
of your AirMiles database and puts on your desktop computer.

The name of the backup file is “AirMIlIDB.PDB". It is located in the backup
directory of your user directory. For example, if your PalmPilot software is
installed at C:\pilot\ and your user name is Joe Shmoe, the backup file would
be:

C:\pilot\jshmoe\backup\AirMiIDB.PDB.

It is a good idea to occasionally save a copy of your backup directory in case
your hard disk crashes or your PalmPilot organizer has a problem.

Restoring a Backup

InstApp Selection

On rare occasions, your PalmPilot organizer may have a problem that requires
you to reinstall your backup file. Do the following steps in order to reinstall
AirMiIDB.PDB file.

1) Make a copy of your current AirMilDB.PDB file.

2) If AirMiles is not installed, follow the installation instructions at the begin-
ning of this manual to install AirMiles.

3) Start the InstApp application. This is the same application you used to
install AirMiles.

4) Install the AirMilDB.PDB file the same way you would install a PalmPilot
application by clicking the Select button, selecting the file, and clicking
the Install button.

|E Filpt Deskiop 1.8 = |

7] svws
1 wedF0- Folder

71 Wt
1 Wser

List Files of Type: | Piln1 Apphications H |

You may have to select “All Files” from the pop up menu at the bottom of the
file selection screen in order display the AirMIIDB.PDB file in the list.

5) Place your PalmPilot organizer in its cradle and press the HotSync button.

6) Start AirMiles. You should see the new data in the program.
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Miscellaneous

Preferences

Preference Screen

You can choose to display dates in the list view either by month and date or
month and year. To change this option, select “Preferences” from the Options
menu and make your choice from the pop-up list.

AirMiles Preferences §)
Date: w Month/Cay

[ ok [ cancel )

Export

Export Screen

The Export feature uses the MemoPad to let you transfer your data to a word
processor or spreadsheet application to further analyze your information.

To Export the information, choose “Export” from the Options menu in the list
view. You will see the following screen.

Export to MemoPad B
Format: Ly
Content:

I:E::{p-:-rt :I I: Cancel :I

Choose the format for the export from the Format buttons. The “Text” format
separates fields with a tab character, and each record is separated with a
return. This is a good choice for exporting to a word processor. The “CSV”
format separates fields with a comma and each record with a return. This is a
good choice for exporting to a spreadsheet.

You can export all your data, or only the data that appears in the list with the
current type, program and year selections. Select which one you want and tap
the “Export” button.

After you export, the data will appear in the Unfiled category in the
MemoPad. To get this information to your desktop, you must first put your
PalmPilot organizer in its cradle and press the HotSync button. After
HotSyncing, find the information in the MemoPad, and copy and paste it to
the program of your choice.
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If you are pasting to a spreadsheet program like Microsoft Excel™, you may
have to set the program up to correctly interpret the tab or comma separated
information. See your user manual for information on converting text to
columns in your spreadsheet application.

Find

You can find information in AirMiles, or any other PalmPilot application, by
tapping the Find button in the lower right corner of your PalmPilot screen.

Find Screen

[ oK [ <ancel +

Enter the word or portion of a word you want to find and tap OK.

You will then see a list of all the places where the word you entered can be
found. Select an entry and tap the GoTo button to go right to the screen that
contains that information.
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Reference

List View
Date Type Desc. Mileage Note
Column Column Column Column Column
Year Selector\ / Type
\ / w fill frpes/ /Selector
w Xl 'aaks / -> F||||:|r'|:|g unﬁ [ Program
0O 11426 % Free ticket!  -150000% Selector
11417 = 5P to Miami 4450
#1112 ™= Miarni to Philly 265037
Reconcile ———| 11412 TY magazine con...500 Scroll
Checkboxes [ 1112 e Rerital car 13000 Bar
=11/ 12 b Hotel bonos 15003
11412 &= Credit card 234500
B 11410 ™= Philly to SFQ 32870
2416 "= Denver to Chicago SE0
916 "= Chicago to Denwver S60 [+
New Record ~
Button [Mew] [ 16032
/ \
Total Total
Checkbox Amount
Date Column The date the transaction was entered.
Type Column A symbol representing the transaction type. Symbols can be:
+ Award
- Flight

Credit Card
=z Phone

& Rental Car
B Restaurant
haw LOdQINg

If no symbol is displayed, it is either an opening balance type, or a type you
entered in the Edit Other Types screen.
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Desc. Column
Mileage Column
Note Column

Type Selector

Program Selector
Scroll Bar

Total Checkbox

Total Amount

New Record Button

Reconcile Checks

Year Selector

The description entered by the user, from the Edit View
The sum of the Miles and Bonus field from the Edit View

A note symbol is displayed if a note is attached to the transaction. You can tap
the note icon and jump directly to the note.

Lets you select the type of transaction to display in the List View. Tap the
selector to display the choices. The last item in the list, Edit Other Types, lets
you add your own types.

Lets you select the program to display

Appears when the list is big enough to scroll. tap the up and down arrows to
scroll, or tap and drag the bar in the middle. The scroll bar is available on
PalmPilot organizers only. Original Pilot users will see scroll buttons in the
lower right corner instead.

Check this to display the total mileage for checked items. Uncheck this to
display the total mileage for items that have a checkbox that is not checked.

The total mileage of either the checked or unchecked items, depending on the
state of the Total Checkbox

Tap this to create a new mileage transaction.

An item may be either unchecked, checked, or cleared. A transaction is ini-
tially created with an unchecked box. While reconciling, you check the items
that appear on your statement. After reconciling, the items will be marked
cleared, and will not have a checkbox in this column.

Lets you specify what year to display.

List View Options Menu

Preferences
Reconcile
Export
About...

Reports |
Preferences... # %
Reconcile... R
Export... « E
About Airililes._.

The List View Options menu is available from the list view by tapping the
Menu icon in the lower left corner of the PalmPilot screen.

Displays the preference dialog, which lets you choose display preferences
Marks all checked items as cleared.
Exports records to the MemoPad

Shows the about dialog
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List View Reports Menu

Mileage Report

Flight Report

I Reports
Mileage Report I
Flight Report « F

Shows the Mileage Report, which displays mileage totals for each year by
expiratioin date.

Shows the Flight Report, which displays mileage totals for flight transactions
only.

Edit View

Type Selector
Program Selector

Date Selector

Miles Field

STIypet Program
elector
Selector
/ e
Date Rirndiles Edit TNZNDP S
Selector 7
Type: w Flight
Miles arn: w United /Segmtlagt
Field SO . e
; Tue 11725797 ;
59””3 5':"1 .............. Seqs 1o Bonus
Field 2. {zwy — | Percent
Expires 3. wears — L Expires
Checkbox - Field
\

Description \

Field [ Done | (Delete..] [ Mote... ] Description

/ | N Selector
Note
Done Delete Button

Button Button

The Edit View is where you enter and edit mileage transactions. To get to the
Edit View, either tap the New button in the List View, or tap on a mileage
transaction in the List View.

Tap the Type Selector to specify the transaction type.

Tap the Program Selector to specify the program that the transaction applies
to.

The date selector defaults to the current date when you create a new transac-
tion. To change the date, tap the date selector and specify a new date.

Enter the mileage amount in this field. For flight transactions, this should not
include bonus miles. Bonus miles are entered in the Bonus field.
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Segments Field Enter the number of segments for a flight in this field. This field is only
available for flight and opening balance transactions.

Bonus Field Enter the bonus amount awarded in this field. Bonus amounts can be calcu-
lated automatically by specifying a bonus percentage on the Program Details
screen. This field is only available for flight and opening balance transactions

Bonus Percentage  This is the percentage amount assigned to the program in the Program Details
screen.

Expires Checkbox  Check this box to indicate that the transaction will expire in the future.
Specify the number of years that the transaction will expire in the Expires
Field. If the transaction will not expire, uncheck this box. This box is not
available for award transactions.

Expires Field Specify the number of years that the transaction will expire in this field.
Transactions will expire on December 31 of the specified year. This field is
only visible if the Expires Checkbox is checked.

Description Field Enter a description of the transaction in this field, like the flight number, credit
card name, hotel name, etc. If you have set up the Description List, you can
select from a list of descriptions from the Description Selector.

Description Selector Tap this to choose from a predefined list of descriptions. To add a description,
choose Edit Description List from the Options menu.

Done Button Records the transaction and goes back to the List View. If the transaction does
not have any mileage specified in the Mileage field, you will be asked to
confirm that you want to enter a transaction with no mileage value.

Delete Button Deletes the current transaction.

Note Button Attaches a note to the transaction. A note icon will appear next to the transac-
tion in the List View.

Edit View Record Menu

| GIILTE N Edit Options |
Delete Record... D
Duplicate Record L

Delete Record Deletes the current record.

Duplicate Record Enters the data currently visible and creates a new transaction that is a copy of
the visible transaction. It then sets the date on the new transaction to today’s
date.
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Edit View Edit Menu

Undo
Cut

Copy
Paste
Keyboard

Graffiti

| Record m Options |

Undx « LU
Cut 4
Copy v C
Faste « P

Keyboard K
Graffiti 0

Removes the last edit operation.

Deletes the selected text and puts it in the Clipboard.
Copies the selected text to the clipboard.

Puts the text in the Clipboard at the current cursor location.

Shows the keyboard dialog that lets you type characters into a field using a
picture of a keyboard.

Displays help for Graffiti. Note that this option is only available to OS 2.0
users.

Edit View Options Menu

Edit Description List

| Record Edit
| Edit Description List 7 E

Brings up the Description List dialog, which lets you add, edit and delete
items that are in the description list. The description list is the list of items that
pop up when you tap the Description Selector.

Edit Description List

The Edit Description List screen lets you add and edit descriptions that will
appear in the Description List that pops up when you tap on the Description
Selector in the Edit View.

To get to the Edit Description List screen, choose “Edit Description List” from
the Options menu in the Edit View
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Edit Desc_ List

(Cone] [Mew ] [Edit. ] [ Delete ]

To add a description item, tap the New button. To edit a description item,
select it and tap the Edit button. To delete a description item, select it and tap
the Delete button. When you have finished, tap the Done button.

Mileage Report

The Mileage report shows you your current balances for each year that miles
will expire on.

To show the mileage report, go to the List View and tap the Menu button in
the bottom left corner of the PalmPilot screen. Then choose Mileage Report
from the Report menu.

Mileage Rpt. w Lnited

Exp.  Miles Hwards Balance

Mone B.ETT 1] B.ETT
2000 16,032 13.880 2,152
1999 1,120 1,120 1]
YT 1] 3,956 -345&

Total Active Miles: 5 373
Lifetime Miles: 23,829
Lifetirne Awards: 18,456

| Done |

The mileage report has 4 columns.

The Exp. column shows the year for which the miles will expire. If miles do
not expire, the word “none” will appear here. If an award was redeemed for
which AirMiles could not find corresponding miles to offset the award, you
will see a column with “???” as the expiration year.
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The Miles column shows you the total miles earned that expire in that year.
This includes flight miles, bonus miles and other miles.

The Awards column shows you the total for miles that have been redeemed
from the expiration year. Note that one award may redeem miles from more
than one expiration year, depending on the size of the redemption and the
number of miles available for an award in that year.

The Balance column shows you the difference between the awards and the
miles for that year.

At the bottom of the screen, you will see 3 totals. The Total Active Miles
shows you the number of miles available for an award. The Lifetime Miles
number is the total number of miles accumulated for the selected program.
The Lifetime Awards column shows you the total number of miles you have
used in awards for the selected program.

Flight Report

The flight report shows you the miles and segments that have been used only
for flights. Many reward programs offer bonuses and special privileges to
people who achieve a certain number of flight miles or awards in a particular
year.

To see the Flight report, select Flight Report from the report menu in the List
View.

Year Seqnents Mhliles
1997 17 14,839
19964 2 1120

Lifetirne Segrents: 19
Lifetime Miles: 15, 959

| Done |

The three columns you see will show you:
* The year the flights were entered

» The number of segments for that year

* The number of flight miles for that year

At the bottom of the screen, you will see your lifetime segments and lifetime
flight miles.
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Edit Other Types

To get to the edit types screen, tap the type selector on the Edit View or List
View, and choose Edit Types from the list that pops up.

This screen lets you add types to the type list and edit the ones you have
added. One entry, called “Other”, is already added to the list when you start
the program. You may delete this item, or add new ones. You are not allowed
to edit types that do not appear on this screen.

Edit Type List

(Done] [Mew | [Edit. ] [ Delete ]

To add a type, tap the New button. To edit a type, select it and tap the Edit
button. To delete a type, select it and tap the Delete button. When you have
finished, tap the Done button

Edit Programs

The Edit Programs screen lets you add and edit programs to the program list.
To get to this screen, choose Edit Programs from the Program selector on the
List View or the Edit View.

Edit Program List

United
Continental

I:D-:-ne:l [ Mew ] [ Edit... :I [Delete]
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To add a program, tap the New button. To edit a program, select it and tap the
Edit button. To delete a program, select it and tap the Delete button. When you
have finished, tap the Done button.

If you add or edit a program, you will see the following screen

Program Details

Program Field

Account Number

Expires Checkbox

Expires Field

Bonus Field

Program Details Program
L~

. Program: 7 Field
Expire |
Checkbox cnt. #: T Acqount
. - Field
Miles Expire: ' 3 wvears
D Bonus:0 % e Expire
Button™ Field
Done Cancel
[ ] [ ‘:I [~ Bonus
\ Field
Cancel
Button

Enter the name of the program in this field. This is the name that will appear
on the program list.

Enter the account number, or other information into this field. This informa-
tion is only for your own reference and is not used by the program in any
other way.

This checkboxes specifies the default for any miles entered for the program.
This default appears on the Edit View when you create or edit a transaction. If
your program miles expire after a given number of years, make sure that this
check box is checked and enter the number of years that miles will normally
expire in for your program. You can override this value for specific transac-
tions in the Edit screen.

Enter the number of years that miles will expire in into this field. This field is
only available if the Expire Checkbox is checked.

If you have achieved a bonus program, enter your bonus percentage in the
bonus field. AirMiles will automatically use this value to compute bonuses on
“Flight” type transactions. The computed bonus value can also be overridden
for individual transactions in the Edit View.
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Preferences

You can choose to display dates in the list view either by month and date or
month and year. To change this option, select “Preferences” from the Options
menu and make your choice from the pop-up list.

AirMiles Preferences §)

Date: w Month/Cay

[ ok [ cancel )

Export

Format

The Export feature uses the MemoPad to let you transfer your data to a word
processor or spreadsheet application to further analyze your information.

To Export the information, choose “Export” from the Options menu in the list
view. You will see the following screen.

Export to MemoPad B

Format:

Content: Al

I:E::{p-:-rt :I I: Cancel :I

Lets you select either text or CSV format. Text format has individual fields
separated by tabs and is good for importing to Word Processors. CSV sepa-
rates field with commas and is good for exporting to spreadsheets.

For more information about exporting, see the Export section in the Miscella-
neous chapter.
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